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  مقدمه 

محيطي قدرتمند براي تجزيه و تحليل معادلات با مشتقات جزيي  Matlabفزار از نرم ا PDEجعبه ابزار 
IBVP در اين جعبه ابزار معادلات با روش اجزاء محدود . در فضاي دو بعدي و زمان ارائه مي كند(Finite 

Element Method) تحليل مي گردند .  

و معادلات با  از جمله ترسيم خصوصيات، نوشتن شرايط مرزي( PDEئل كمترين نياز ما فرموله كردن مسا
  : در خط فرمان تايپ كنيد Matlabبراي شروع كار پس از اجراي . است) مشتقات جزيي

>> pdetool 

  : اين محيط به شكل زير است. باز مي شود PDEبا اجراي اين دستور محيط گرافيكي براي حل 
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  اين ابزار حل نمود؟  چه مسايلي را مي توان با

براي نمونه، معادلات بيضوي و . به عنوان مدل رياضي پديده هاي مختلف استفاده مي شود PDEمعادلات 
جريان داخل خلل و فرج هاي نامنظم و براي هذلولوي را مي توان در حالت هاي دائم و غير دائم انتقال حرارت، 

  . جريان پتانسيل به كار برد

  : ل زير را انجام مي دهيمبه اين منظور مراح

  براي ايجاد موضوع GUIاستفاده از  -

  CSGايجاد هندسه با  -

  تعريف شرايط مرزي -

   PDEتعيين ضرايب قابل تغيير و مسئله  -

  مش بندي كامل  -

  با تغيير متغيرهاي وابسته مشخص كردن سيستم حل كننده  -

  شبيه سازي خواص تعريف شده  -

استفاده مي كند،  Finite Elements Methodكه از روش  MATLABا ب PDEپروسه حل معادلات 
  : شامل مراحل زير است

  (draw mode)تعريف كردن هندسه موضوع  •
  (boundry condition mode)تعريف شرايط مرزي  •
  PDE (PDE mode)انتخاب ضرايب معادله  •
  FEM (mesh mode)فيلتر و صلاحديد  •
  PDE (solve mode)مشخص كردن شرايط اوليه و حلگر  •
  PDEپس پردازش و حل  •

  . معروف است (elliptic)بيضوي ، معادله ديفرانسيل زير است كه به نام معادله PDEمعادله پايه جعبه ابزار 

െ׏. ሺܿݑ׏ሻ ൅ ݑܽ ൌ ݂ 

با مشتقات زماني مرتبه  خاص مانند معادله بالاهذلولوي و سهموي با عملگرهاي به طور متشابه از معادلات 
 c. به صورت ضرايب معادله و متغير تعريف مي شوند uو مجهول  f,a,cدر اين معادله . و دوم استفاده مي كنيم اول

  . باشد  2*2مي تواند يك ماتريس 
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݀
ݑ߲
ݐ߲ െ .׏ ሺܿݑ׏ሻ ൅ ݑܽ ൌ  معادله هذلولوي                         ݂

െ׏. ሺܿݑ׏ሻ ൅ ݑܽ ൌ  ݈ܾ݉݁݋ݎܲ ݁ݑ݈ܽݒ݊݁݃݅ܧ                               ݑ݀ߣ

݀
߲ଶݑ
ଶݐ߲ െ .׏ ሺܿݑ׏ሻ ൅ ݑܽ ൌ  معادله سهموي                       ݂

. مي توانند به زمان نيز بستگي داشته باشند f,d,a,cو سهموي و هذلولوي، ضرايب  PDEبراي معادلات 
  : داردبيضوي وجود  PDEبه منظور حل معادلات يك حل كننده غير خطي 

െ׏. ሺܿሺݑሻݑ׏ሻ ൅ ܽሺݑሻݑ ൌ ݂ሺݑሻ 

  : همه حل كننده ها مي توانند سيستم به شكل زير را تحليل كنند. هستند uتابعي از متغير  f,a,cكه 

െ׏. ሺܿଵଵݑ׏ଵሻ െ .׏ ሺܿଵଶݑ׏ଵଶሻ ൅ ܽଵଵݑଵ ൅ ܽଵଶݑଶ ൌ ଵ݂ 

െ׏. ሺܿଶଵݑ׏ଵሻ െ .׏ ሺܿଶଶݑ׏ଵଶሻ ൅ ܽଶଵݑଵ ൅ ܽଶଶݑଶ ൌ ଶ݂ 

  ): اساسي(شرط ديريخله . تعريف شده اند uشرايط مرزي زير براي اسكالر 

ݑ݄ ൌ ݎ
௢௡ ௧௛௘ ௕௢௨௡ௗ௥௬
ሱۛ ۛۛ ۛۛ ۛۛ ۛۛ ሮۛ ߲Ω 

  : (Genetalized Neumann)نيومن تعميم يافته 

ሬ݊Ԧ. ሺܿݑ׏ሻ ൅ ݑݍ ൌ ݃
௢௡
ሱሮ ߲Ω 

n  بردار نرمال خارجي وr,h,q,g ستند كه در توابع با مقادير مختلط ه∂Ω در يك (. تعريف شده اند
باشند و براي  uمي توانند تابعي از  r,h,q,gدر موارد غير خطي، ضرايب .) صفر هستند r,gمعادله همگن مقادير 

براي سيستم هاي دوبعدي شرايط . سهموي و هذلولوي، ضرايب مي توانند تابعي از زمان باشند PDEمعادلات 
  : ديريخله به صورت زير هستند

݄ଵଵݑଵ ൅ ݄ଵଶݑଶ ൌ  ଵݎ

݄ଶଵݑଵ ൅ ݄ଶଶݑଶ ൌ  ଶݎ

  : و شرايط مرزي نيومن تعميم يافته نيز به صورت

ሬ݊Ԧ. ሺܿଵଵݑ׏ଵሻ ൅ ሬ݊Ԧ. ሺܿଵଶݑ׏ଵଶሻ ൅ ଵݑଵଵݍ ൅ ଶݑଵଶݍ ൌ ݃ଵ 

ሬ݊Ԧ. ሺܿଶଵݑ׏ଵሻ ൅ ሬ݊Ԧ. ሺܿଶଶݑ׏ଵଶሻ ൅ ଵݑଶଵݍ ൅ ଶݑଶଶݍ ൌ ݃ଶ 
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  : و تركيب شرايط مرزي به صورت زير است

݄ଵଵݑଵ ൅ ݄ଵଶݑଶ ൌ  ଵݎ

ሬ݊Ԧ. ሺܿଵଵݑ׏ଵሻ ൅ ሬ݊Ԧ. ሺܿଵଶݑ׏ଵଶሻ ൅ ଵݑଵଵݍ ൅ ଶݑଵଶݍ ൌ ݃ଵ ൅ ݄ଵଵߤ 

ሬ݊Ԧ. ሺܿଶଵݑ׏ଵሻ ൅ ሬ݊Ԧ. ሺܿଶଶݑ׏ଵଶሻ ൅ ଵݑଶଵݍ ൅ ଶݑଶଶݍ ൌ ݃ଶ ൅ ݄ଵଶߤ 

همچنين شرايط مرزي ديريخله، شرط اساسي يا . باشدبه منظور ارضاي شرايط مرزي ديريخله مي  μكه 
  . ضروري و شرايط نيومن، شرط طبيعي يا ذاتي مي باشد

  

   PDEتعريف يك مسئله 

كه ما قصد مسئله اي  .يا رابط گرافيكي استفاده مي كنيم GUIبراي شروع همان طور كه قبلا اشاره شد، از 
ݑ׏ሺെداريم آن را حل كنيم، معادله پواسون  ൌ ݂ሻ هندسه اين مسئله به صورت . مي باشدquite complex 

  . است و شرايط مرزي از نوع ديريخله و نيومن هستند

 Toolboxگزينه  startرا وارد مي كنيم يا از منوي  pdetoolدر خط فرمان دستور  Matlabبا اجراي 
بعد از . را انتخاب مي كنيم PDETool GUIو بعد گزينه  Partial Differential Equationو سپس گزينه 

  : به صورت زير ظاهر مي شود GUIلحظاتي 
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Grid  را از منويoption/grid همچنين . فعال كنيدsnap  را از منويoptions اين . فعال نمائيد
تعدادي از اشكال ساده  GUI. رد نظر استوهندسه جسم ماولين مرحله، ترسيم . گزينه به ترسيم كمك مي كند

به كار  CGS Modelاين اشكال براي ايجاد ساختار مدل هندسي يا . مانند بيضي، مستطيل، دايره و مثلث را دارد
      با انتخاب هر عضو ... . و  C1و دايره اول  R1به عنوان مثال مستطيل اول . هر عضو يك برچسب دارد. مي روند
  . مي توان ويرايش هاي دلخواه را انجام داد copy,cut,clear,deleteاز گزينه هاي . آن را جابجا كردمي توان 

 

كليه موضوعات با يكديگر به طور پيش فرض . استفاده كرد shiftبراي انتخاب دو يا چند عضو مي توان از 
 مانند در اين فيلد وارد كرد، ري ، مي توان مقادير ديگ(C1+R1+R2+E1). فيلد ويرايش فرمول جمع مي شوند در

(R1+C1+R2)‐E1   

حال . را انتخاب كنيد Save Asگزينه  Fileاز منوي  M‐Fileبه عنوان يك  CSGمدل به منظور ذخيره 
 Boundryو يا با انتخاب  Ω∂را با استفاده از آيكون  Boundry Mode. مي توان شرايط مرزي را تعريف كرد

Mode  از منويBoundry د مي كنيمايجا .  
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 Boundryقسمت انتخاب شده، پنجره محاوره اي  تك تك مرزها بر روي Double‐clickبا 

Condition يك يك عبارت در اينجا نوع شرايط مرزي را انتخاب كرده و به عنوان . نمايان مي شودMatlab  شرط
ப௡در حين تغيير شرايط مرزي، شرط نيومان . مرزي خود را اعمال مي كنيد

ப୳
ൌ െ5 در . را بر مرزها اعمال كنيد

    وارد  gدر جلوي پارامتر را  5‐را انتخاب مي كنيم و عدد  Neumannشرط  Boundry Conditionپنجره 
كليك  OKروي . را صفر وارد مي كنيم qخالص مقدار پارامتر  Neumannيك يك شرط براي اعمال . مي كنيم
شرايط مرزي كه به رنگ قرمز هستند انجام مي دهيم و پس از اعمال  اين كار را بر روي تك تك مرزهايي. مي كنيم

  . روي هر كدام از مرزهاي قرمز، به رنگ آبي در مي آيند
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  ، نوع معادله را مشخص PDEاز منوي  PDE Specificationيا انتخاب  PDEبا كليك بر روي آيكون 
.׏െمعادله بيضوي به عنوان مثال . مي كنيم ሺܿ. ሻݑ׏ ൅ ݑܽ ൌ و  f=10.0را انتخاب مي كنيم و ضرايب  ݂

a=0  وc=1.0 را وارد مي كنيم .  

  

، سطح به قطعات Mesh>Initailize Meshيا منوي  ∆مثلثي از طريق آيكون  meshبالاخره با ايجاد 
مش ريزتر و به  Meshاز منوي  Refine Meshاگر نياز به حل دقيقتري داريم، با انتخاب . مثلثي تقسيم مي شود

  . دقيقتر و درعين حال زمان بر مي رسيم حل

   

   

matlab1.ir

matlab1.ir



  Matlabبا نرم افزار  (PDE)حل معادلات ديفرانسيل با مشتقات جزئي 
 دكتر حميد روان بخش: استاد راهنما  محمد سرفراز

9 
 

سپس حل مساله  .را انتخاب مي كنيم Solve PDEگزينه  solveاز منوي . اكنون آماده حل مساله هستيم
  . يك سرس رنگ خاص استفاده مي شودبه عنوان پيش فرض از . ترسيم مي شود

  

  از طريق آيكون                  . ز راه حل وجود دارددر اينجا روشهاي مختلفي براي ترسيم براي كمك به تصور ما ا
Plot Selection  و يا در قسمتParameters  منوي ازPlot  انواع . نوع ترسيم مي رسيمبه پنجره انتخاب

شكل سه  plotو يا با انتخاب  متعددي از ترسيم موجودند كه تنظيمات دلخواه خود را انجام داده و خارج مي شويم
  . بعدي آن نمايش داده مي شود
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، گراديان جواب را نيز مشاهده Heightو  colourدر قسمت  abs(grad(u))و حتي مي توان با انتخاب 
  . كرد

  

  

  

  

  

  

  

  . در قسمت بعد، مثالهاي ديگري را حل مي كنيم
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  نمونه هاي كاربردي 

از  Applicationاز گزينه  براي مشاهده اين كاربردها. شوددر اين بخش نمونه هاي كاربردي ارائه مي 
   .قابل دسترسي هستند Optionمنوي 

  

  

  

  

  

  

  

  

  

  

  

  : اين كاربردها همان طور كه مشاهده مي شود، عبارتند از

  (Generic Scalar)سنجش نوعي  •
 سيستم نوعي و عام •

 ساختارهاي مكانيكي از نوع تنش صفحه اي •

  كرنش صفحه اي ساختارهاي مكانيكي از نوع •
 الكترو استاتيك •

 انتقال حرارت •

 پخشندگي •

  ...و 
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توسط پارامترهاي خاص نظير  PDEهنگامي كه از يك نمونه كاربردي استفاده مي كنيم، ضرايب مربوط به 
از  …Parametersاين پارامترها با انتخاب گزينه . مدول يانگ در مسائل مكانيكي جايگزين مي شوند

  . ندوارد مي شو PDEمنوي 

  

  انتقال حرارت

  : معادله انتقال حرارت يك معادله سهموي مي باشد كه به صورت زير است

ܥߩ
߲ܶ
ݐ߲ െ .׏ ሺ݇ܶ׏ሻ ൌ ܳ ൅ ݄. ሺ ௘ܶ௫௧ െ ܶሻ 

֜ 

߲
ݔ߲ ൬݇

߲ܶ
൰ݔ߲ ൅

߲
ݕ߲ ൬݇

߲ܶ
൰ݕ߲ ൅

߲
ݖ߲ ൬݇

߲ܶ
൰ݖ߲ ൅ ݍ ൌ ௣ܥߩ

߲ܶ
ݐ߲  

• ρ  چگالي 

 ظرفيت گرمايي  Cيا  ୮ܥ •

• k  ضريب انتقال حرارتي 

• q  نرخ انتقال گرما 

• h  ضريب انتقال گرماي جابجايي يا همرفتي 

• ܶୣ ୶୲  ياஶܶ  دماي خارج برحسب كلوين 

  . را به صورت تابعي از زمان به دست آورد T(x,y,z)با حل اين معادله مي توان توزيع دما 

  : معادله سهموي ساده مي شوداص در حالت دائم به يك حالت خاين معادله 

െ׏. ሺ݇ܶ׏ሻ ൌ ܳ ൅ ݄. ሺ ௘ܶ௫௧ െ ܶሻ 

  رساناي گرماي دائم و يك بعدي 

را با  GUIابتدا . متر را در نظر بگيريد 0.2و قطر  4به عنوان مثال انتقال حرارت يك بعدي ميله اي به طول 
يق منوي        است از طر 0.2*4چون ابعاد شكل ما بصورت . باز مي كنيم pdetoolتايپ 

options>axis limits مقادير زير را وارد مي كنيم .  
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را  0.2*4سپس يك مستطيل . را انتخاب مي كنيم Snapو  Gridگزينه هاي  Optionsسپس از منوي 
  : رسم مي كنيم
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  : را انتخاب مي كنيم Boundary>Boundary Modeسپس 

   

  : مرز به شكل زير در مي آيد
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به  Neumannبا شرط  دوبار كليك مي كنيم و شرط نيومن محيط اطراف آنرا  تك تك مرزهابر روي 
  . مي كنيمتعريف  (g=0)صورت عايق 

  

  

  

  

  

  

  

  :تعريف مي كنيم (g=10) 10در انتهاي ميله شار حرارتي را 
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   :بندي را انجام مي دهيم و بعد مش را براي حل دقيقتر ريزتر مي كنيم Meshسپس 

  

  

  

  

  

  

  

  

  

  

  

  . انتخاب مي كنيم Options>Applicationرا از منوي  Heat Transferگزينه سپس 
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. تنظيمات زير را انجام مي دهيمرا انتخاب مي كنيم و  PDE Specificationگزينه  PDEسپس از منوي 
h را برابر صفر قرار مي دهيم به اين معني كه در سطح، تبادل حرارتي نداريم .  

  
  

  

  

  

  

  

  

  . را انتخاب مي كنيم تا مسئله حل شود Solve PDE، گزينه solveسپس از منوي 

 

 

 

 Parameters، گزينه plotبدين صورت كه از منوي . براي درك بهتر مي توان نوع ترسيم را انتخاب نمود
   .را مي زنيم Plotيا  Closeرا انتخاب مي كنيم و نوع ترسيم را تغيير مي دهيم سپس گزينه 
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يا گراديان  (heat flux)موارد ديگري مانند جريان گرما  Propertyعه مي توان با تغيير در زير مجمو

  . حرارتي را مشاهده كرد
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  : اگر گراديان حرارتي را ترسيم كنيم

  

  رساناي گرماي دائم و يك بعدي 

يك مربع چرخانده شده به به صورت لوزي داخل مسئله دوبعدي شامل يك مربع جاسازي شده 
و  10مربع داراي خواص ناحيه اي به صورت ضريب انتقال حرارت . درجه نسبت به اولي مي باشد 45اندازه 

هر دو ناحيه . مي باشد 1و چگالي  2و ضريب هدايت  4مشخصات انتقال گرمايي و لوزي داراي  2چگالي 
  . مي باشند 0.1گرمايي يكسان داراي ظرفيت 
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Heat Transfer  را از منويOptions>Application در منوي . فعال كنيدOptions  گزينه
Axis limits  و يك لوزي  3مربعي به ضلع . قرار مي دهيم [0.5 3.5‐]را انتخاب و محورها را در محدوده

  . سپس مطابق اشكال ادامه مراحل را دنبال نمائيد. ترسيم كنيد Draw>Polygonبوسيله 
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matlab1.ir

matlab1.ir



  Matlabبا نرم افزار  (PDE)حل معادلات ديفرانسيل با مشتقات جزئي 
 دكتر حميد روان بخش: استاد راهنما  محمد سرفراز

22 
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  ) همگرالوله (عبور جريان سيال از يك نازل 

. بيان مي شود uبرحسب گراديان پتانسيل مجهول  vاگر سيال غيرچرخشي باشد، بردار سرعت
چون چگالي ثابت . مي باشد v=grad(u)به صورت  uو  vرابطه مساله را بدين صورت بيان مي كنيم كه 

  . خواهيم داشت div(grad(u))=0پس ما نياز به حل معادله . مي باشد div(v)=0است درنتيجه 

سپس از منوي . را فعال مي كنيم Snapsو  Gridگزينه هاي  Optionsابتدا از منوي 
Options  گزينهAxes limits را انتخاب مي كنيم و حدود زير را براي محورها انتخاب مي كنيم :  

  
    را انتخاب و يك چندضلعي مانند شكل زير ترسيم  Polygonگزينه  Drawسپس از منوي 

  . مي كنيم
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 Drawسپس از منوي . را انتخاب مي كنيم Axes Equalگزينه  Optionsسپس از منوي 
  : را انتخاب و دو دايره مانند شكل زير رسم مي كنيم Ellipse/circle(centered)گزينه 

  

را وارد  (C2‐(P1+C1))عبارت  set formulaر براي اينكه شكل لوله ما درست شود در كاد
  : را مي زنيم Enterمي كنيم و بعد 

  
را انتخاب مي كنيم تا به شكل زير  Boundary Modeگزينه  Boundaryسپس از منوي 

  : درآيد
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را مطابق  Dirichletيا  Neumannسپس بر روي هركدام از مرزها دوبار كليك كرده و شرايط 

   .ارد مي كنيمجدول زير و

 شماره مرز  نوع شرط مرزي  gضريب   rضريب  hضريب qضريب
1  Neumann  0  0  ‐  ‐ 
2  Dirichlet  ‐  ‐  1  0 
3  Neumann  0  0  ‐  ‐ 
4  Neumann  0  0  ‐  ‐ 
5  Neumann  0  0  ‐  ‐ 
6  Neumann  0  0  ‐  ‐ 
7  Neumann  10*y  0  ‐  ‐ 
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  : 7به عنوان مثال براي مرز شماره 

  
را انتخاب مي كنيم و تنظيمات زير را وارد  PDE Specificationگزينه  PDEسپس از منوي 

به اين دليل ظاهر  yترم . است برسيم div(y*grad(u))=0‐مي كنيم تا به معادله مورد نظر كه همان 
  . ها در نظر مي گيريم و نيمه بالايي لوله را بررسي مي كنيمxشده است كه جريان را موازي محور 

  
انتخاب مي آن قدر را  Refine Meshو بعد گزينه  Mesh Modeگزينه  Meshوي حال از من

  . را انتخاب مي كنيم Solve PDEگزينه  Solveحال از منوي . تا به دقت مطلوب برسيم كنيم
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كه همان پتانسيل است را نشان مي دهد كه با توجه به مقدار مشخص شده براي  uمقدار تصوير 

به طور مثال مقدار پتانسيل در قسمت . در هر قسمت از لوله معين است uقدار هر رنگ در سمت راست، م
مي باشد و در قسمتي كه لوله باريك مي شود، كمترين مقدار  22بالاي لوله بيشترين مقدار خود يعني 

  . خود را دارد

 همان طور كه مي دانيم رابطه پتانسيل با سرعت رابطه اي معكوس است و سرعت همان گراديان
را انتخاب و تغييرات زير  Parametersگزينه  Plotبراي مشاهده تغييرات سرعت از منوي . پتانسيل است

  . را اعمال مي كنيم
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  .را مي زنيم Plotسپس دكمه 

  
  

در بالاي لوله سرعت كمترين مقدار و در قسمت . نمودار نيز همان نكته مذكور را بيان مي كند
از  را ببينيم از منوي contourاگر بخواهيم بردار سرعت و سطح . را دارد، سرعت بيشترين مقدار انتهايي
  . را انتخاب و تغييرات زير را اعمال مي كنيم Parametersگزينه  Plotمنوي 
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  : بردارهاي سرعت را مي بينيم Plotبعد از زدن دكمه 

  
 هنيزگ solveين منظور از منوي بد. انتقال داد Matlabرا مستقيما به محيط  uمي توان مقادير :نكته مهم

Export Solution هدش هبساحم ريداقم ،ديئات زا سپ و مينك يم باختنا ار u طيحم دراو Matlab دنوش يم. 
   :مينك يم پيات Command window هرجنپ رد و هتفر Matlab همانرب يلصا طيحم هبحال 

>>u 

   .دنوش يم هداد شيامن u ريداقم يمامت بيترت نيدب
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